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Differentiation BasicsDifferentiation BasicsDifferentiation BasicsDifferentiation BasicsDifferentiation Basics
June Preszler

TIE Education Specialist

Before you begin, there are a few (well, maybe more than a few) basic elements to
differentiation that will make the journey smoother for you and your students.

Remember, you are probably using various aspects of differentiation right now in your classrooms.
But are you being explicit about the ways in which you differentiate? In others words:

• Are you conscious of the efforts you make to meet the needs of all your students?
• Do you keep track of the ways you address individual learning styles and preferences?
• Do you arrange classrooms and structure lessons to increase student motivation?
• Whenever possible, do you provide students with options and choices regarding how they

are going to learn and how they are going to show their learning?
• Do you vary the ways in which you assess student learning?
• Do you use cooperative learning and grouping strategies to increase student participation?

Odds are that you already incorporate some or most of these aspects of differentiation in your
classrooms. As you venture into the world of differentiated instruction, look at what you are
already doing. Then consider the principles and strategies provided in this booklet. Select and use
those that complement the efforts you already make to meet the diverse needs of your students.
Keep in mind that differentiation shouldn’t be something that complicates your day or life.
Although additional work and effort are required up front, the payoff comes later in the lesson of
study or even in the school year. The payoff comes when students achieve more in your class-
rooms, become more involved in classroom discussions, smile more during their school days, and,
yes, even score higher on various assessments.

In The Differentiated Classroom: Responding to the Needs of All Learners, Carol Ann Tomlinson
offers the following framework for helping teachers differentiate in the classroom (15).

Source:
Tomlinson, Carol Ann. The Differentiated Classroom: Responding to the Needs of All Learners.

Alexandria, VA: ASCD, 1999.

Differentiated Instruction

Respectful Tasks Flexible Groups Ongoing Assessment

Teachers Differentiate Via

Teachers Differentiate According to Student

Content Process Product

Readiness Interest Learning Profile

Teachers Use a Range of Instructional and Management Strategies

multiple intelligences
jigsaws
taped material
anchor activities
graphic organizers

varied texts, materials
literature circles
tiered lessons
tiered centers
tiered products

learning contracts
grouping activities
orbital studies
independent studies
questioning strategies

interest centers
interest groups
varied homework
compacting
journal prompts
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Content, Process, and ProductContent, Process, and ProductContent, Process, and ProductContent, Process, and ProductContent, Process, and Product

Once you’ve decided to include differentiation in your classroom routines, you are
confronted with the question: Okay, so what exactly can I differentiate? Differentiation

usually includes one or more of the following areas:

• Content (what students learn)
– Includes curriculum topics, concepts, or themes
– Reflects state or national standards
– Presents essential facts and skills
– Differentiates by preassessing student skills and understandings, then matching learners

with appropriate activities
– Provides students with choices in order to add depth to learning
– Provides students with additional resources that match their levels of understanding

• Process (how students learn)
– Refers to how students make sense or understand the information, ideas, and skills being

studied
– Reflects student learning styles and preferences
– Varies the learning process depending upon how students learn

• Product (the end result of student learning)
– Tends to be tangible: reports, tests, brochures, speeches, skits
– Reflects student understanding
– Differentiates by providing challenge, variety, and choice

Author Carol Ann Tomlinson offers the learning environment as a fourth way to differentiate.
She suggests that the learning environment is the “weather” of a classroom and includes the
classroom’s operation and tone. Class rules, furniture arrangement, lighting, procedures, and
processes all affect the classroom’s mood.

Sources:
Heacox, Diane. Differentiating Instruction in the Regular Classroom: How to Reach and Teach All

Learners, Grade 3-12. Minneapolis: Free Spirit, 2002, pages 10-11.
Tomlinson, Carol Ann. Fulfilling the Promise of the Differentiated Classroom: Strategies and Tools for

Responsive Teaching. Alexandria, VA: ASCD, pages 4-6.
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KUD Samples from High School Teachers

Wendy Larson, Lead-Deadwood Middle School
The Holocaust, 8th grade language arts and social studies unit

Larisa Bailey, Lead-Deadwood Middle School
Fractions, Decimals, and Percents, 6th grade math

Laura Shuck, Kim Fundaun, & Brooke Kilian, Lead-Deadwood High School
Heredity and Genetics Unit, 9th grade general science

Source:
Tomlinson, Carol Ann. “Educators at Work: Differentiating Curriculum and Instruction.” 2005 ASCD Annual

Conference. Orlando, FL. 30 March 05-1 April 05.

K: Students will know the effects of the Holocaust.

U: Students will understand how prejudice can lead to cruel and often unimaginable events.

D: Students will write about the effects of prejudice in a variety of creative/informational formats.

K: Students will know that fractions, decimals, and percents name parts of a whole.

U: Students will understand that a given amount can be named as a fraction, a decimal, and a
percent. They will understand that although the name changes, the value of the amount stays
the same.

D: Students will convert given number values into a fraction form, a decimal form, and a
percent form.

K: Students will know heredity, dominant/recessive traits, Mendel’s theory, inheritance, Punnett
squares, probability, meiosis, and asexual/sexual reproduction.

U: Students will understand that change is inevitable.

D: Students will do the following:
• Predict what a person might look like using the Punnett square;
• Draw and explain mitosis and meiosis;
• Rate websites;
• Classify dominant and recessive traits as they relate to Mendel’s pea plants;
• Show a model of a DNA strand with a key;
• Interview a person whose career or hobby deals with genetics or heredity;
• Survey people in the class for their eye and hair color and then chart the results using a pie,

line, or bar graph.
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A fundamental premise of differentiating instruction is that you, as the classroom leader,
 have to take steps that guarantee your students will learn what they need to meet curriculum

guidelines and state standards.

That means before you begin a unit of study, you need to know exactly what you expect from
students. Of course, this is nothing new, but too often it’s a simple step we neglect as we instruct
our students. One suggestion many practitioners of differentiation offer is the KUD method. As
you prepare a unit, explicitly detail exactly what it is you want students to Know (K), Understand
(U), and Do (D).

Carol Ann Tomlinson, author of numerous articles and books focusing on differentiation, suggests
that only when educators have defined for themselves the outcomes they expect from students,
can they begin to effectively develop units of study designed to meet student needs. She says the
first step in designing an effective and differentiated unit is to focus. Using KUD helps teachers
maintain focus.

Steps:Steps:Steps:Steps:Steps:
1. Before beginning any unit, decide what you want students to Know (K), Understand (U),

and Do (D). Keep in mind the following elements that differentiate each of these processes.

2. Use the chart as a framework to guide instruction.
3. Prominently display the KUD chart so students know the expectations.

KUD Samples from High School Teachers

Patrick Johner, Todd County High School
Land and Water of North Africa and Southwest and Central Asia, 9th grade unit

K: Students will know the land and water features of the region.

U: Students will understand how the region’s major rivers are important to the region and why
much of the world is economically dependent upon the region.

D: Students will build a layered-look book on the land and water of the region.

Know: (facts, vocabulary, definitions, places, information)
Example: Multiplication tables

Understand: (essential truths, principles and generalizations, big ideas of a discipline,
I want students to understand that)
Example: I want students to understand that multiplication is another way to add numbers

Do: (basic skills, thinking skills, planning skills, uses verbs or phrases)
Example: Students solve problems requiring multiplication.



Differentiation: From Planning to Practice Grades 6-12 by Rick Wormeli 
 

Respectful Tasks 

 If the focus of a lesson is teaching students how to write a conclusion to an essay or report, we 

should ensure that all students are learning to write conclusions.  This may seem obvious, but many 

teachers think they are differentiating when they give students alternative tasks that have little 

connection to a lesson’s objectives. For example, some students may not be ready to fully analyze a 

period of history that we’re teaching, so we ask them to create an inviting travel brochure about the era 

to use an advertisement for future time-travelers.  What does this teach them about historical analysis? 

Not much. 

 Instead of providing an unrelated assignment we could tier the lesson with respectful tasks.  For 

students who are struggling to learn, we might break off the chunks they can do and progressively add 

complexity.  In a lesson about historical analysis, students at the introductory level of understand may 

be able to tackle only one aspect of the period or the culture under consideration – perhaps scientific 

progress or religion.  For student in the middle range, we could ask them to consider two or three ideas.  

But limit the amount of evidence required to substantiate a conclusion.  Or, we might prime their minds 

by asking them to first analyze something much closer to the modern age.  For advanced students, we 

might ask them to analyze multiple aspects of the historical period along different themes, require 

primary resource evidence to substantiate their claims, or use the identified themes to compare the 

historical period to modern times. 

 The point of respectful tasks is to never drift far from standards of excellence to provide 

meaningful (developmentally appropriate) experiences for all students.   

 

 

 

 

 

 

 

 

 

 

 



Low prep 
Differentiation 
 

• Choices of books 
• Homework options 
• Reading buddies 
• Varied journal prompts 
• Orbitals 
• Varied pacing with 
anchor options 
• Student-teacher goal 
setting 
• Work alone/together 
• Whole-to-part 
explanations 
• Flexible seating 
• Varied computer 
programs 
• Design-A-day 
• Varied supplementary 
materials 
• Options for varied 
modes of expression 
• Varying scaffolding on 
same organizer 
• Let’s Make a Deal 
projects 
• Computer mentors 
• Think-pair-share by 
readiness, interests, 
learning profile 
• Use of collaboration, 
independence, and 
cooperation 
• Open-ended activities 
• Mini workshops to 
re-teach or extend skills 
• Jigsaw 
• Negotiated criteria 
• Explorations by 
interest 
• Games to practice 
mastery of 
information and skill 
• Multiple levels of 
questions 

High prep differentiation 
 

• Tiered activities and labs 
• Tiered products 
• Independent studies 
• Multiple texts 
• Alternative assessments 
• Learning contracts 
• 4-MAT 
• Multiple-intelligence 
options 
• Compacting 
• Spelling by readiness 
• Entry points 
• Varying organizers 
• Lectures coupled with 
graphic organizers 
• Community mentorships 
• Interest groups 
• Tiered centers 
• Interest centers 
• Personal agendas 
• Literature circles 
• Stations 
• Complex instruction 
• Group investigation 
• Tape-recorded materials 
• Teams, games, and 
tournaments 
• Choice boards 
• Think-Tac-Toe 
• Simulations 
• Problem-based learning 
• Graduated rubrics 
• Flexible reading formats 
• Student-centered writing 
formats 
 

- Carol Tomlinson 



Student Generated Questioning
Description  
These are activities which engage students in developing questions during or 
following instruction.  

Purpose  
Student Generated Questioning is a way for teachers to assess student 
comprehension during or after activities or an entire unit of study.  It also 
provides opportunities for reinforcement of what has be learned and leads students 
to higher order thinking.  Students reflect upon their learning and consider what 
they know, what they thought they knew, what they want to know more about, and 
what they still want to learn.  

Connection to Inquiry and Standards:
Students ask questions and make observations to find answers to their questions.  
Student generated questioning includes students asking who, what, when, where, why, 
and how questions. The technique requires careful listening and use of speaking 
skills, PA Reading/Writing/Speaking/Listening Standard 1.6. 

Materials 
Copies of Question Wheel or other graphic organizer for students to record their 
questions. Or copies of Matrix Cube.  Paper.

Procedure
The teacher structures opportunities for students to develop questions regarding 
the information covered in the activities, reading selections, or unit of study.  
Students are given a copy of the Question Wheel, other graphic organizer to 
complete, or a Matrix Cube.  Students generate who, what, where, when, why, and how 
questions.  For the Question Wheel, students are assisted in writing questions 
through the suggestion of verbs.  The Matrix Cube incorporates Bloom’s taxonomy 
and cooperative learning.  Students roll a die that is labeled with a pre-specified 
question word.  (A blank Matrix Cube is attached.) One student forms the question 
using the word, one student paraphrases the question, another student answers the 
question, and a fourth student records the question and answer.

Resource
Wiederhold, Chuck (1995).  Cooperative learning and higher level thinking : the Q-
matrix.  San Juan Capistrano, Calif. : Kagan Cooperative Learning. 



Reproduced with permission from Blackburn, Rigor Is Not a Four-Letter Word.
Copyright 2008 by Eye On Education, Inc., Larchmont, NY. All rights reserved. www.eyeoneducation.com
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How to Play… 

 
 

 
                     Question Sheet       Answer Sheet 

 
Scattergories 

List 1 
Scattergories 

One 
1.  A boy’s name 1.  BobBob  
2.  A river  2.  Burnside RiverBurnside River 
3.  An animal 3.  BisonBison 
4.  Things that are cold 4.  BricksBricks  
5.  Insects 5.  Bumble BeeBumble Bee 
6.  

 

 

What You Need: 
•  Watch or Timer 
•  Answer Sheets 
•  Question Sheets 

•  Pencils 
•  Letters 

 

Setting Up the Game: 

1. Photocopy the answer and the question sheets (attached) so that you have 
enough for each team.   

2. Photocopy and cut the “Letter Page” and put the cut letters into a Ziploc bag 
or hat.  If you want to reuse the letters, you can laminate the page before you 
cut the letters out. 

B 
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How to Play 

1. Give each team a question sheet (List #1), an answer sheet and a pencil.   

2. To start the game, you need to pick a letter from the “Letter Bag” and show 
it to the teams.  All answers for this round will start with this letter.   

3. Set the timer at 4 minutes.  (You can change the amount of time depending 
on the age and level of your group.) 

4. All teams quickly fill in the first column of their answer sheets.  Answers 
must fit the category and begin with the letter picked from the bag.   

5. When the timer stops, teams stop writing. 

6. Scoring A Round:  Have the teams read their answers out loud for number 
1.  Teams correct their own answer sheets by putting a circle around an 
answer that DOES NOT match any other teams’ answer.  Continue reading 
answers until all 12 categories have been scored.  Then, score 1 point for 
each of your circled answers.  Put your score at the top of the column of 
your answer sheet.  

7. Starting a New Round:  Set the timer, pick a new letter and give out 
Question Sheet List #2.   

8. Winning the Game:  After 3 rounds have been played, all players/teams 
total the 3 scores on their answer sheets.  The player/team with the highest 
score is the winner. 

 

Adapt the Game:   
• Have one team think of a category and another 

team pick a letter.  Set the timer and see which 
team can come up with the most answers. 

• You can do Scattergories in languages other than 
English.  Have the players use their Aboriginal 
language instead.   

• You could have a northern theme where the 
answers have to be from the north. 
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Answer Sheets – Photocopy this sheet and cut in half.  Each 
team will need one answer sheet. 

 

Scattergories 
ONE 

Scattergories 
TWO 

Scattergories 
THREE 

1. 1. 1. 
2. 2. 2. 
3. 3. 3. 
4. 4. 4. 
5. 5. 5. 
6. 6. 6. 
7. 7. 7. 
8. 8. 8. 
9. 9. 9. 
10. 10. 10. 
11. 11. 11. 
12. 12. 12. 

 
 
 

Scattergories 
ONE 

Scattergories 
TWO 

Scattergories 
THREE 

1. 1. 1. 
2. 2. 2. 
3. 3. 3. 
4. 4. 4. 
5. 5. 5. 
6. 6. 6. 
7. 7. 7. 
8. 8. 8. 
9. 9. 9. 
10. 10. 10. 
11. 11. 11. 
12. 12. 12. 
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Question Sheets – Photocopy this sheet and cut in half.  Each 
team will need one question sheet. 

 

Scattergories 
List 1 

Scattergories 
List 2 

Scattergories 
List 3 

1.   A boy’s name 1.   Authors 1.   School supplies 
2.   A river  2.   Bodies of water 2.   Things that are hot 
3.   An animal 3.   A bird 3.   Heroes 
4.   Things that are cold 4.   Countries 4.   A girl’s name 
5.   Insects 5.   Cartoon characters 5.   Fears 
6.   TV Shows 6.   Holidays 6.   TV Stars 
7.   Things that grow 7.   Things that are square 7.   Colours 
8.   Fruits 8.   In the NWT 8.   A fish 
9.   Things that are black 9.   Clothing 9.   Fruits 
10. School subjects 10. A relative 10. Provinces or States 
11. Movie titles 11. Games 11. Sports equipment 
12. Musical Instruments 12. Sports Stars 12. Tools 

 
 
 

Scattergories 
List 4 

Scattergories 
List 5 

Scattergories 
List 6 

1.   Breakfast foods 1.   Trees 1.   Lunch foods 
2.   Gifts 2.   A book 2.   Song titles 
3.   Flowers 3.   Things that are red 3.   Household chores 
4.   Ice cream flavours 4.   Movie stars 4.   Vegetables 
5.   A drink 5.   In the town 5.   Things that bother you 
6.   Toys 6.   Arctic things 6.   A store 
7.   Cities 7.   Item in the fridge 7.   Excuses for being late 
8.   Things in the kitchen 8.   Bad habits 8.   Foreign cities 
9.   Ocean things 9.  Things you’re afraid of 9.   Things that grow 
10. Nicknames 10. Restaurants 10. Things in the bedroom 
11. Hobbies 11. Things at the beach 11. Things that are yellow 
12. Parts of the body 12. Kinds of candy 12. Furniture 
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Blank Question Sheets - Use this blank question sheet to make up 
your own “Scattergories.” 

 

Scattergories 
List 7 

Scattergories 
List 8 

Scattergories 
List 9 

1. 1. 1. 
2. 2. 2. 
3. 3. 3. 
4. 4. 4. 
5. 5. 5. 
6. 6. 6. 
7. 7. 7. 
8. 8. 8. 
9. 9. 9. 
10. 10. 10. 
11. 11. 11. 
12. 12. 12. 

 
 
 

Scattergories 
List 10 

Scattergories 
List 11 

Scattergories 
List 12 

1. 1. 1. 
2. 2. 2. 
3. 3. 3. 
4. 4. 4. 
5. 5. 5. 
6. 6. 6. 
7. 7. 7. 
8. 8. 8. 
9. 9. 9. 
10. 10. 10. 
11. 11. 11. 
12. 12. 12. 
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Letter Page – Make one copy of this sheet and cut out the letter squares.  
Put the letter squares in Ziploc bag.  If you want to reuse the sheet, you 

could laminate it before you cut it up. 
 

A B C D E 

F G H I J 

K L M N O 

P Q R S T 

U V W X Y 

Z     
 



LIST 13

VIdeo gameS

eLecTronIc gadgeTS

Board gameS

ThIngS ThaT uSe a remoTe

card gameS

InTerneT LIngo

offenSIVe WordS

WIreLeSS ThIngS

compuTer parTS

SofTWare

WeBSITeS

game TermS

1.

2.

3.

4.

5.

6.

7.

8.

9.

10.

11.

12.
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ThIngS In a grocery STore

reaSonS To quIT your job

ThIngS ThaT have STrIpeS

TourIST aTTracTIonS

dIeT foodS

ThIngS found In a hoSpITaL

food/drInk ThaT IS green

Weekend acTIvITIeS

acronymS

Seafood

chrISTmaS SongS

WordS endIng In “-n”

1.

2.

3.

4.

5.
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WordS WITh doubLe LeTTerS

ChILdren’S bookS

ThIngS found aT a bar

SporTS pLayed IndoorS

nameS uSed In SongS

foodS you eaT raW

pLaCeS In europe

oLympIC evenTS
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Microsoft Word 07: Supporting Reading and Writing Skills 
Virginia AT Coordinators  

Use of Color  
 

 Changing background color can help students with vision issues but also those with LD 
and ADHD issues. 

• Pale yellow background – reduces eye strain 
• Pale green or pink backgrounds increase the ability to concentrate in ADHD students. 
• Light blue or green backgrounds help students with dyslexia. 
• Dark blue or black background with light yellow text is often helpful for students with visual 

impairments.  
 

*When given choice, students will choose the combination that is right for 
them.  Students use their preferred color combinations while composing and 
editing and then change back to black letters on white background for 
printing. 

 
 
                                To change the background color of the document: 
                                    go to the page layout tab –select page color. 
 

                               
 
 

 Changing the font color of words that you want to emphasize can help students 
organize and find important information. You can also highlight text for emphasis and 
to guide students through the document. 

 
                        To change the font color of a certain word:  

 select the text that you want to highlight,  
 choose the font color tool from the Home tab of the Ribbon. 

  
                        To highlight specific text:  

 select the text that you want to highlight 
 choose the highlighting tool from the home tab of the ribbon.    

                             
     

                         
 

Highlighting tool 
 
Text color tool 



Cutting Down on Keystrokes 
Students with physical disabilities need to use as few keystrokes as possible.  There are various 
ways to cut down on keystrokes while using Word. 
 
Replace as you type: 
This feature allows the student to customize Word using short key combinations.  For instance, the 
letters xx when typed together can represent the student’s name and other information generally 
entered into a document.   
 
 
             To set up a key combination to represent a longer phrase: 
      Word Options – Proofing – Auto Correct Options – Auto Correct Tab– Replace as you type.   
      Type in an obscure letter combination to represent a longer phrase. 
 
             Example – typing xx expands to Barbara Cannon Mrs. Davis   B1 
 

                 
 
 

                      
 
 
 
 



 
Making Assistive Options easier to use by putting them into the Quick Access 
Bar: 
One of the nice features of Word 07 is the Quick Access Bar which allows you to customize the 
commands you use most often.  Once you know what tools a student will need or which ones you will 
use most often to make accessible materials for students, those commands can be conveniently 
placed in the Quick Access Bar. 
 
                             To Put Commands into the Quick Access Bar 

• Word Options – Customize – Choose All Commands – Choose Desired Tool – Add  
• Tool will be placed on the quick access bar 

 
            * in this example, the page color command is added to the Quick Access Bar 
 

           
 
 
 
 
 
 
 
 
 



WORD and Text Readers 
 
Word can be used in conjunction with text readers to help students by reading the material to them. 
This can also help teachers by providing a way to read text besides having the teacher read it.   In our 
county,  we currently use the Kurzweil Reader to provide text reading of Word documents.  The 
Kurzwiel Reader can also read material from the web, PDF files and documents scanned into the 
Kurzweil format.  There are many text readers on the market today.  Here is a partial list of well 
known textreaders. 
 
Free Readers:  
These generally allow you to cut and paste text into the reader and read it.  The voices are not great 
but they provide a free level of support for students.  
 
Read Please –  
Natural Reader – 
 
Full Featured Readers: 
Text Help Read and Write Gold -   
Kurzweil Reader –  
 
 
 
                      To use a text reader with Word documents and other text. 
 
Any Text Reader:  Copy the text and paste it into the text reader.  
 
Full Featured Text Readers (Kurzweil, Texthelp)  Open the text reader.  From the File menu, pick 
Open.  Open the document in the reader. 
 
Kurzweil: Open the document in Word, choose print from the Office Button. Choose the Kesi printer.  
The document will be made into an image file and will open in the Kurzeil reader maintaining the 
formatting of the original document. 
 
Texthelp only: Reads within Word 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Use of Text Spacing 
 

Some students read better if there is more space between the words in a sentence or 
space between sentences.   
 

To add spaces between words: go to the find and replace menu on the Home Tab.    
• Enter 1 space in the FIND line 
• Enter 2 or more spaces in the REPLACE line.   

 
             * If you add 3 spaces, the words will look like this. 
 

Normal spacing                     The girl in the hat is pretty. 
3 spaces between words     The   girl   in   the   hat   is   pretty. 

 
 
 
 

To add spaces between sentences: go to the find and replace menu on the Home Tab.  
• Enter 2 spaces in the FIND line 
• Enter 3 or more spaces in the REPLACE line.   

 
*If you add 4 spaces, the words will look like this. 

 
Normal spacing                          The girl in the hat is pretty.  The boy in the sunglasses is handsome. 
4 spaces between sentences.   The girl in the hat is pretty.    The boy in the sunglasses is handsome. 
 
 
                                           

                            
 
 
 
 
 

Add spaces to 
change the 
spacing between 
words and 
sentences here. 



Bullets: 
Use Bullets to help students brainstorm and organize ideas. 
 
Fruits that I love 

� Apples 
� Cherries 
� Bananas 
� Oranges 

 
Auto Summarize – 
Auto Summarize helps students who have difficulty reading and finding the main points in lengthy 
articles and documents.  Auto Summarize cuts out some of the text and attempts to keep the main 
points.  This is very helpful when using e-text. This is used by busy executives and is loved by 
struggling readers and writers. 
 

                                  To use Auto Summarize  
Go to: Word Options – Customize – All commands – Auto Summary Tools – Add 

 
    *it must be added to the Quick Access Tool Bar. It is not in the ribbon by default. 
                    

                                          
 
 
 
 
 
 
 
 

Auto Summarize 
Menu lets you make 
various types of 
summaries 
 
Auto Summarize lets 
you cut down the size 
of the document by 
different percentages 
to make it shorter or 
longer as you choose. 



Word Count 
By using the Word Count Feature, you can collect data to see if students are improving the length 
and complexity of their writing. In Word 07, It is very easy to see the word count of pages, selections 
or documents. 
 

To find  the word count for an entire document: 
• Look at the bottom left hand corner of the document.  
• The total word count for the document is listed in the corner. 

 

                    This shows the word count for an entire document. 
 
 
 

To find the word count for a selection: 
• Select the text you want to count 
•  Look at the bottom left corner.   
• The word count will be next to the word count  

for the entire document.   
 
*If you want to know the word count for selections that are not located 
 next to each other, select the first selection, hold down the CTRL key,  
then select the next selection 

 
 

                       This shows the number of words in the selection  
                                                            and the number of words in the entire document.   
 
 
 
Readability statistics: 
 

You can check on how your students are doing by enabling Readability 
Statistics. Over time you can get data to see if the student is increasing the length of their documents 
or the complexity of their words and sentences. Once enabled, the statistics appear at the end of any 
spelling and grammar check that you do. 
 
 



 
 

To Check the “grammar with spelling” check box 
• Select the “show enable readability statistics. 
• Word Options – Proofing - Correcting spelling and grammar in Word 
• readability statistics” check box. 

 
   

                   
 
 
 
 
 
 
 
 
 
 
 
 



Using Comments  
Comments can be used to give information to the student without changing what they have written.  It 
can be helpful in teaching better writing technique. 
 

To add a comment:  
Go to Review Tab – New Comment 

 

                                          
 
*Comments will look something like this when used: They can be easily deleted from the document 
when the student makes a final draft. 
 

 
 
 
Using Voice Comments: 
Voice Comments can be used in many ways to support students.  Voice comments can be set to read 
the document to students who have trouble with reading so that you do not have to read the 
document to the student.  You can also give instructions for the student that are embedded at the 
correct location. You might also wish to have key words defined or pronounced for students. Some 
students are auditory learners and can be helped by the addition of an audio file to the document. 
 
Voice Comments need to be placed in the Quick Access Bar. To do that: 

• Word Options – Customize – All commands.   
• Find Voice Comment and click on the Add button.   
• The Voice Comment Icon will appear in the Quick Access Bar. 

 
To make a Voice Comment: 

• Place the cursor in the document where you wish to have a comment.  
• Click on the Voice Comment Icon.   
• The sound recorder will come up.   
• Record you comment.  

•  A speaker icon will appear in the document where the sound file is 
embedded.   

• The student can click on the icon to hear the file.   
 
 
 
 
 
 



Using the Synonyms feature with Find/Replace 
 to alter the readability level of a document. 
 

Sometimes there are words in a document that need to be changed to 
ones that a student can decode and comprehend.  This can be done by using the Synonym feature to 
find a more suitable word and then replacing the difficult word with the easier word throughout the 
document. 
 

To change a word choice 
• Place cursor on the targeted word.   
• Right click synonyms.  A list of synonyms will appear.  
• Choose the one that would be more understandable.   

 

                                                                                
 
 
 

If  you want to replace the word in multiple places in the document 
• Go to the replace menu on the Home Tab.  
• Place the original word in the Find line 
• Place the synonym you wish to use in the Replace line.   
• All examples of the word will be changed within the document. 

 

             
  
 

 
Here is a selection in which the 
word SUITABLE is replaced 
with FITTING. 



 
Turning off the auto spell checker/grammar options. 
When students are tested for their writing SOL, they are not allowed to use a spell checker that prompts them 
that a word in incorrectly spelled. They are also not allowed to have grammar errors pointed out to them.  For 
that reason, it may be beneficial for the auto spell feature to be turned off. 

 
To turn of the auto spell checker feature: 

• Word Options‐ Proofing 
•  Uncheck auto spelling and grammar options. 

 
 

   
 
 
The auto spell checker/grammar options can also be turned off at the same location for 
specific documents. 
 

                                

Uncheck all boxes in this category 



Downloading videos with closed captioning 
Please note that closed captioning can be downloaded for Windows Media Player videos only.  

In order to view closed captioning on Windows Media Player videos, make sure to select a video with closed 
captioning, which is identified by the  closed captioning icon. 

Before downloading any files, make sure to create a folder on your computer for the specific video. 
 

Download the video file by right clicking on the  download icon and selecting Save Target As. Make sure to 
download the video within the folder created for the video. 
 
Please make sure that the closed captioning file (.smi file) and the video file (.asf file or .wmv file) have the same 
file name. For example, if the video file is "test123.asf" then the closed captioning file should be "test123.smi". 
Also, both files must be saved within the same folder.  

Download the closed captioning file by right clicking on the  closed captioning icon and selecting Save Target 
As. Make sure to download the video within the folder created for the video. 

Open Windows Media Player and click on Play within the Menu Bar.  Go to Captions and Subtitles and make sure 
"On if available" is selected.   
 
Click on Play again and go to Defaults and make sure "(Closed captions)" is selected under the second drop-down 
box, Captions and Subtitles.  
 
Click on Tools within the Menu bar to select Options.  Within Options, click on the Security tab.  
If you do not have access to the Security tab, please contact your IT Department.   
 
Select to Run script commands when present and Show local captions when present.  Then click on OK to save 
your security changes. 
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Next, click on the video file saved within the video folder. The video will open within Windows Media Player and 
the closed captioning text will begin as the narrator begins speaking.
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